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Preface

This documentation describes how to install, configure, and use the iWay Emulation Adapter
(3270/5250). It is intended for system administrators who are responsible for planning an
enterprise software environment.

Note: This Release 7.0.x content is currently being updated to support iWay Release 8.0.x
software. In the meantime, it can serve as a reference for your use of iWay Release 8. If you
have any questions, please contact Customer_Success@ibi.com.

How This Manual Is Organized

This manual includes the following chapters:

Chapter/Appendix Contents

1 Introducing the iWay
Emulation Adapter
(3270/5250)

Provides an overview of the iWay Emulation Adapter
(3270/5250) and describes how to install it.

2 Understanding Telnet
Designer

Describes the Telnet Designer user interface. This
includes a description of available menus and
options.

3 Using Remote Procedure Call
Mode

Describes how to use the iWay Emulation Adapter
(3270/5250) to create a Remote Procedure Call
(RPC) of an emulation session and save it as a
stand-alone Java program.

4 Creating XML Schemas and
iWay Business Services

Describes how to create XML schemas and iWay
Business Services that will be used to execute the
iWay Emulation Adapter (3270/5250).

5 Using Emulation and
Recorder Modes

Describes how to use Emulation mode, which
allows you to access a mainframe session directly
from your workstation, and how to use Recorder
Mode, which allows you to record an emulation
session so that you can play back at a later time to
simulate a live mainframe session.

A Emulator Keyboard Mapping Describes how your keyboard maps to 3270/5250
keys when you use the emulator.

Documentation Conventions

The following table describes the documentation conventions that are used in this manual.

iWay Emulation Adapter (3270/5250) User's Guide  5
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Convention Description

THIS TYPEFACE or
this typeface

Denotes syntax that you must enter exactly as shown.

this typeface Represents a placeholder (or variable), a cross-reference, or an
important term. It may also indicate a button, menu item, or dialog
box option that you can click or select.

underscore Indicates a default setting.

Key + Key Indicates keys that you must press simultaneously.

{ } Indicates two or three choices. Type one of them, not the braces.

| Separates mutually exclusive choices in syntax. Type one of them,
not the symbol.

... Indicates that you can enter a parameter multiple times. Type only
the parameter, not the ellipsis (...).

.

.

.

Indicates that there are (or could be) intervening or additional
commands.

Related Publications

Visit our Technical Content Library at http://documentation.informationbuilders.com. You can
also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a
message board. It is an interactive network of more than 3,000 developers from almost every
profession and industry, collaborating on solutions and sharing tips and techniques. Access
Focal Point at http://forums.informationbuilders.com/eve/forums.

Related Publications
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You can also access support services electronically, 24 hours a day, with InfoResponse
Online. InfoResponse Online is accessible through our website, http://
www.informationbuilders.com. It connects you to the tracking system and known-problem
database at the Information Builders support center. Registered users can open, update, and
view the status of cases in the tracking system and read descriptions of reported software
issues. New users can register immediately for this service. The technical support section of 
http://www.informationbuilders.com also provides usage techniques, diagnostic tips, and
answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212)
736-6130. Customer Support Consultants are available Monday through Friday between 8:00
a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can
also give you general guidance regarding product capabilities. Please be ready to provide your
six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders
representative about InfoResponse Online, or call (800) 969-INFO.

Help Us to Serve You Better

To help our consultants answer your questions effectively, be prepared to provide
specifications and sample files and to answer questions about errors and problems.

The following tables list the environment information our consultants require.

Platform

Operating System

OS Version

JVM Vendor

JVM Version

The following table lists the deployment information our consultants require.

Adapter Deployment For example, iWay Business Services Provider, iWay
Service Manager

Container For example, WebSphere

Preface
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Version

Enterprise Information System
(EIS) - if any

EIS Release Level

EIS Service Pack

EIS Platform

The following table lists iWay-related information needed by our consultants.

iWay Adapter

iWay Release Level

iWay Patch

The following table lists additional questions to help us serve you better.

Request/Question Error/Problem Details or Information

Did the problem arise through
a service or event?

Provide usage scenarios or
summarize the application that
produces the problem.

When did the problem start?

Can you reproduce this
problem consistently?

Describe the problem.

Describe the steps to
reproduce the problem.

Specify the error message(s).

Help Us to Serve You Better
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Request/Question Error/Problem Details or Information

Any change in the application
environment: software
configuration, EIS/database
configuration, application, and
so forth?

Under what circumstance does
the problem not occur?

The following is a list of error and problem files that might be applicable.

Input documents (XML instance, XML schema, non-XML documents)

Transformation files

Error screen shots

Error output files

Trace files

Service Manager package to reproduce problem

Custom functions and agents in use

Diagnostic Zip

Transaction log

For information on tracing, see the iWay Service Manager User's Guide.

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff
welcomes your opinions regarding this document. You can contact us through our website, 
http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of
training courses for this and other Information Builders products.

Preface
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For information on course descriptions, locations, and dates, or to register for classes, visit
our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an
Education Representative.

Information Builders Consulting and Training
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Chapter1 Introducing the iWay
Emulation Adapter (3270/5250)

The iWay Emulation Adapter (3270/5250) captures mainframe 3270 or 5250 screens
and their output to create a Java™ program, an XML file for a Remote Procedure Request
(RPC) solution, or components for a web-based solution. This web-based solution can be
used to replace green-screen displays with sophisticated user interfaces.

Using the adapter also enables you to invoke mainframe applications from non-
mainframe environments, such as UNIX and Windows, without modifying the mainframe.
You can have logic and data associated with legacy mainframe programs available to a
new generation of applications.

In this chapter:

Integrating Mainframe Logic

Remote Procedure Call Development Mode

Installing the iWay Emulation Adapter (3270/5250)

Deployment Information for the iWay Emulation Adapter (3270/5250)

Integrating Mainframe Logic

Telnet is a standard protocol for remote logon over the Internet. The name is an abbreviation
of Telecommunications Network. When a user establishes a Telnet connection to a remote
mainframe computer, the user's local system emulates a terminal connected directly to the
mainframe.

The iWay Emulation Adapter (3270/5250) allows you to view your online application as an
object that can be run from any front-end or application server. The choice of the deployment
method depends on your business need and the desired result.

Depending on how you want to run your online application, the adapter can transform your
3270 or 5250 screens into HTML pages, wrap the application screens inside a Java program,
or create an iWay RPC (remote procedure request) to transform the output of any number of
screens into an answer set.
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The Telnet Adapter redefines the way a 3270 or 5250 online applications are perceived. You
can use the Telnet Adapter to create re-usable business objects. Captured within these
business objects are the actual screens and business logic behind them that have been
running within your enterprise. These business objects can be deployed from high-tech
applications and servers to be used as part of any integration effort.

iWay Emulation Adapter (3270/5250) Components

The Telnet Adapter includes the following components:

Telnet Designer. A GUI tool you can use to emulate the screens, the process flow, and key
strokes in a mainframe session. For more information, see Understanding Telnet Designer
on page 19.

Telnet API. A Java-based programming API used to programmatically control the execution
and manipulation of screen-based programs.

Remote Procedure Call Development Mode

In a production environment, your application can communicate with a mainframe session
using files. The application sends keystrokes to the mainframe in an XML request document,
and the mainframe returns screen data in an XML response document. You can use these
documents to integrate a mainframe session into your application. This is called RPC (Remote
Procedure Call) mode.

Using RPC mode enables you to create a standalone Java program that contains the methods
for each screen and a subset of Telnet API commands embedded within it that allow you to
compile the program and run the application from any Java enabled environment. The Telnet
Designer automatically generates the Java code for you. In this way, you do not have to
manually enter the code for your programs. Manual customization to the generated Java
program is required to enable greater functionality.

For more information on using RPC mode, see Using Remote Procedure Call Mode on page
33.

Emulating and Recording Mainframe Sessions

Whether you are developing your application using RPC mode, the development process allows
you to emulate and record a mainframe session.

You can emulate a mainframe session directly from your workstation using the Telnet
Designer, which displays standard 3270/5250 screens.

Remote Procedure Call Development Mode
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You can record your interaction with a mainframe session and later play it back to simulate a
live mainframe session. Simulating a session enables you to develop an application offline.
This is useful in situations when the mainframe is unavailable.

For more information on emulating and recording your mainframe session, see Using Emulation
and Recorder Modes on page 59.

Development Roadmap

The following image illustrates an overview of the development process when using the iWay
Emulation Adapter (3270/5250).

1. Introducing the iWay Emulation Adapter (3270/5250)
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Installing the iWay Emulation Adapter (3270/5250)

The iWay Emulation Adapter (3270/5250) links new business applications to mainframe-based
business logic through IBM 3270/5250 terminal screens and data streams. It enables you to
transform your 3270/5250 mainframe screens into HTML pages or to create a Remote
Procedure Call (RPC) request to transform the output of screens into an answer set. The
adapter provides a simple, lightweight, and scalable way to reuse the business logic and data
of terminal applications.

The iWay Emulation Adapter (3270/5250) requires client components that you must configure
after installing iWay 7.0.2 SM. The two client components are:

The run-time component, which is supported on:

Microsoft Windows 2000 with SP2 and Windows 2003.

UNIX.

OS/390 and z/OS (under UNIX System Services (USS)).

The Telnet Designer, which is supported on:

Microsoft Windows 2000 with SP2.

Windows 2003.

Windows XP SP1.

Note: If you plan to run the Emulation Adapter on a UNIX system, you must install iWay 7.0.2
SM and the Emulation Adapter client components on the UNIX system and also install the
adapter client components on a Windows system. This enables you to use the Telnet Designer,
which is supported on Windows only.

The iWay Emulation Adapter requires client components, including the Telnet Designer, that
must be configured after installing iWay 7.0.2 SM.

Procedure: How to Install the iWay Emulation Adapter Client Components

To install the iWay Emulation Adapter client components:

1. Unzip the iwtelnettool.zip archive file to a location on your file system.

The iwtelnettool.zip archive file is located in the following directory:

<iway_home>\etc\setup\emulation

Note: If you are using the iWay Emulation Adapter with iWay Service Manager (iSM), it is
recommended that you install the iWay Emulation Adapter client components under the
iSM root directory. For example:

Installing the iWay Emulation Adapter (3270/5250)
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<iway_home>\etc\setup\emulation\iwtelnettool\

When you unzip the iwtelnettool.zip archive file, the following directory structure is created:

Note: A logs subfolder is created in this directory structure when logs are initially
generated.

2. Ensure that the iwtelnet.jar file is available in the following iSM lib directory:

C:\Program Files\iWay7\lib

If the iwtelnet.jar file is not available in this location, you can copy it from the following
directory:

<iway_home>\etc\setup\emulation\iwtelnettool\lib

Deployment Information for the iWay Emulation Adapter (3270/5250)

The iWay Emulation Adapter (3270/5250) can be used in conjunction with one of the following
components.

iWay Service Manager

iWay Explorer

iWay Business Services Provider (iBSP)

When hosted in an iWay environment, the adapter is configured through iWay Service Manager
and iWay Explorer. iWay Explorer is used to configure adapter connections, create web
services, and configure event capabilities.

When the adapter is hosted in a third party application server environment, iWay Explorer can
be configured to work in a web services environment in conjunction with the iBSP.

Deployment Information Roadmap

The following table lists the location of deployment and user information for components of the
iWay Emulation Adapter (3270/5250).

1. Introducing the iWay Emulation Adapter (3270/5250)
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Deployed Component For more information, see

iWay Service Manager iWay Service Manager User's Guide

iWay Explorer iWay Installation and Configuration

iWay Business Services
Provider (iBSP)

iWay Installation and Configuration

iWay Service Manager

iWay Service Manager is the heart of the Universal Adapter Framework and is an open
transport service bus. Service Manager uses graphical tools to create sophisticated integration
services without writing custom integration code by:

Creating metadata from target applications.

Transforming and mapping interfaces.

Managing stateless processes.

Its capability to manage complex adapter interactions makes it ideally suited to be the
foundation of a service-oriented architecture.

iWay Explorer

iWay Explorer uses an explorer metaphor to create XML schemas and web services for the
associated object. In addition, you can create ports and channels to listen for events.

iWay Business Services Provider

The iWay Business Services Provider (iBSP) exposes (as web services) enterprise assets that
are accessible from adapters regardless of the programming language or the particular
operating system.

iBSP simplifies the creation and execution of web services when running:

Custom and legacy applications.

Database queries and stored procedures.

Packaged applications.

Terminal emulation and screen-based systems.

Deployment Information for the iWay Emulation Adapter (3270/5250)
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Transactional systems.

Web services is a distributed programming architecture that solves Enterprise Application
Integration (EAI) hurdles that other programming models cannot. It enables programs to
communicate with one another using a text-based, platform- and language-independent
message format called XML.

Coupled with a platform and language independent messaging protocol called SOAP (Simple
Object Access Protocol), XML enables application development and integration by assembling
previously built components from multiple web services.

1. Introducing the iWay Emulation Adapter (3270/5250)
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Chapter2
Understanding Telnet
Designer

This section describes the menus and options available in the Telnet Designer.

In this chapter:

Navigating Telnet Designer

Telnet Designer Menu Options

Working With Telnet Designer Projects

Telnet Designer Tools
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Navigating Telnet Designer

The Telnet Designer window contains three panes:

The left pane is the navigation pane. It provides access to your Telnet adapter project
folders and Telnet session data. Two tabs at the bottom of the pane access project folders
(Project name) and your Telnet sessions (Sessions). A default project named system is
provided with Telnet Designer. The Project tab displays the current project name.

The right pane displays the current session design activity.

The Console Window appears at the bottom of the window and displays Telnet Designer
status and messages.

Navigating Telnet Designer
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Telnet Designer Menu Options

The Telnet Designer main menu appears at the top of the window and beneath that, a series of
icons that represent the most frequently used options. The following image shows the main
menu and the option icons.

The following table lists and describes the options available from the main menu.

Menu Menu Options Description

File Exit Close Telnet Designer.

View Output Window Activate the Output tab of the Console Window.

Viewer Window Open a Viewer window in the right pane. The pane
provides a tab for each loaded viewer data. Not
currently used.

Screen DB
Viewer

Open a Screen DB Viewer in the right pane. This
pane displays the currently loaded screenDB. The
pane provides a tab for each loaded screenDB.

Project New Project Create a new project.

Open Project Open an existing project.

Tools Emulator Open the Terminal Emulator tool.

Player Server Open the Player Server tool.

Options Open the Options dialog box in which you set
options for the Emulator and Player Server.

2. Understanding Telnet Designer
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Menu Menu Options Description

Window Cascade Display the windows that appear in the right pane in
a cascading format.

Tile Display the windows that appear in the right pane in
a tile format.

This menu also provides a list of all windows that are open in the right
pane. You can select a window from this list to activate it in the right
pane.

Help About Open the About window, which displays Telnet
Designer build and version information.

The following table shows each Telnet Designer icon and describes its function.

Icon Description

Create a new project.

Open an existing project.

Save the current project.

Open the Terminal Emulator tool.

Open the Player Server tool.

Open the About window, which displays version information about Telnet
Designer.

This icon appears in the upper right corner of the Telnet Designer window.

Telnet Designer Menu Options
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Working With Telnet Designer Projects

The Telnet Designer offers the following project options:

New Project

Open Project

Note: Though Export RPC Repository appears as an option, it is not currently supported.

Procedure: How to Create a New Project

To create a new Telnet Designer project:

1. From the Project menu, select New Project.

The New Project dialog box opens, requesting a name for the project, as shown in the
following image.

2. Type a name for the new project.

3. Click OK.

The new project node, with its subfolders, appears in the left pane.

To exit the New Project window at any time, click Cancel.

Procedure: How to Open an Existing Project

To open an existing project:

1. From the Project menu, select Open Project.

The Open Project dialog box opens displaying a list of existing Telnet Designer projects.

2. Select a project from the Existing Projects list.

3. Click Open.

The selected project, with its subfolders, appears in the left pane. The project tab at the
bottom of this pane displays the project name.

2. Understanding Telnet Designer
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Project Tab

When you open or create a project, the project tab in the left pane displays the name of the
current project and a series of subfolders are displayed in the pane, as shown in the following
image.

As you design with Telnet Designer, the project items are saved to the following folders:

dumps. Contains dump files created using Recorder mode.

rpcs. Contains sessions designed using RPC mode.

Working With Telnet Designer Projects
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screenDB. Contains screens, with a screen identifier, from all design sessions in the
project. Screens that are identical between design sessions are automatically identified
when encountered during a new design session.

Telnet Designer Tools

Telnet Designer offers the following selections under the Tools menu:

Emulator

Player Server

Options

Emulator Tool

Access the Emulator tool from either the main menu (Tools, then Emulator) or from the
Emulator tool icon. The Terminal Emulator dialog box opens with the Connection tab displayed,
as shown in the following image. In this window, you set the parameters that allow you to
connect to the system you want to emulate, and select the Telnet Designer mode in which you
will work.

2. Understanding Telnet Designer

iWay Emulation Adapter (3270/5250) User's Guide  25



The following table lists and describes the parameters available in the Terminal Emulator
Connection tab.

Parameter Description

Host DNS name or IP address of the system you will connect to for
the emulation session.

Terminal Type of terminal you will use for the emulation. The available
selections are tn3270 and tn5250.

SSL/TLS This option allows you to enable a Secure Sockets Layer
(SSL)/Transport Layer Security (TLS) security connection.

Port Port number of the connection.

Mode Emulation mode that Telnet Designer will use for the session.
The modes are Emulation, RPC (Remote Procedure Call), and
Rec (Recorder).

Click Run to connect to the designated system. Click Cancel to exit the Terminal Emulator
dialog box.

Telnet Designer Tools
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The Advanced tab of the Terminal Emulator dialog box is shown in the following image. The
Advanced tab provides additional settings to further define the connection.

The following table lists and describes the parameters available in the Terminal Emulator
Advanced tab.

Parameter Description

Extended Attributes Allows the session to send extended attributes from the back-
end application. These attributes are returned to the
application without modification. The following attributes are
allowed: background color, character set, field outlining, field
validation, and foreground color.

Note: If you select a code page in the Language parameter
that supports double byte character set (DBCS) code pages,
the extended attributes parameter is the default.

Language The code page for the language used by the host system.

2. Understanding Telnet Designer
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Parameter Description

LU Name Allows 3270 application users to specify a particular terminal
name (LU) or Pool name (LU pool) to use in its connection with
the mainframe. As a result, the mainframe can then dedicate
specific connections and privileges to specific telnet ports.

Click Run to connect to the designated system. Click Cancel to exit the Terminal Emulator
dialog box.

The Security tab of the Terminal Emulator dialog box is shown in the following image. When the
SSL/TLS check box is selected in the Connection tab, the Security tab provides additional
security settings that must be defined.

Telnet Designer Tools
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The following table lists and describes the parameters available in the Terminal Emulator
Security tab.

Parameter Description

SSL Version Select one of the Secure Sockets Layer (SSL) and Transport
Layer Security (TLS) protocol versions to use for the
connection:

SSL v3

TLS v1

By default, TLS v1 is selected.

Server Certificate Select one of the following server certificate options:

Always Accept

Ask Before Accepting

By default, Always Accept is selected.

Preferred CipherSuite Select an available CipherSuite to use for the connection from
the drop-down list.

By default, None is selected.

The implementation of the SSL/TLS security connection relies on the implementation of Oracle
Java Secure Socket Extension (JSSE). JSSE is included as a standard component of JRE
Version 1.4 and higher. SSL Version 3.0 and TLS Version 1.0 are currently supported by iWay
Emulation Adapter (3270/5250).

iWay Emulation Adapter (3270/5250) uses its own trust store file to store server certificates.
The file is called iway_telnet_jssecacerts and will be created in the following directory:

<JRE-home>\lib\security

If the Always Accept value is selected in the Security tab of the Telnet Designer for the Server
Certificate parameter or ACCEPTCERTIFICATE='1' is included in the RPC scripts, then an
unrecognized server certificate will be stored in the trust store file. If the Ask Before Accepting
value is selected in the Security tab of the Telnet Designer for the Server Certificate parameter
or ACCEPTCERTIFICATE='2' is included in the RPC scripts, then a dialog window with the
certificate information is displayed and you must decide whether or not to accept the server
certificate.

2. Understanding Telnet Designer
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You can also select a cipher suite to use for encryption and integrity check purposes. However,
it is possible that a server may not support the preferred cipher suite and a connection will not
be established as a result. If no preferred cipher suite is selected, the Telnet client will
negotiate with the server based on a set of cipher suites and use one that both parties can
support.

The Record mode of the Telnet Designer still records unencrypted data. As a result, you can
not use SSL/TLS to connect to a player server, even if the recorded dump is recorded from a
SSL/TLS session.

Player Server Tool

To access the Player Server tool, click Tools from the menu bar and select Player Server. You
can also click the Player Server icon on the toolbar. The Player Server dialog box opens, as
shown in the following image.

The Player Server dialog box allows you to run prerecorded emulations that were created in
Recorder mode. A selection of prerecorded emulation files appears in the Available Dumps list.
Click Run to activate the selected simulation. Click Cancel to exit the Player Server.

Options

You can edit certain attributes for the Emulator and Player Server tools through the Options
dialog box. To access the Options dialog box, click Tools from the menu bar and select
Options.

The available options appear in the Options dialog box under the following tabs:

Emulator

Telnet Designer Tools
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Player Server

The Options dialog box is shown in the following image with the Emulator tab selected.

The following table lists and describes the Emulator options.

Option Description

Font Size Determines the font size of the emulation.

Auto Reconnect Automatically re-establishes the emulator session if the connection
to the host is lost.

2. Understanding Telnet Designer
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The Options dialog box is shown in the following image with the Player Server tab selected.
These options set the attributes used when running the Player Server tool to connect to a
recorded dump.

The following table lists and describes the Player Server options.

Option Description

Initial Port The port on the local machine used to connect to a recorded dump.
Each new player session will automatically select a new port number in
this port sequence, adding one to the previous port number.

Max sessions The maximum sequence of port numbers allocated to the player server.
As each new player session is opened, a new session in this sequence
of numbers will be assigned. Port numbers in the sequence are reused
after all numbers in the sequence have been assigned. This also
indicates the maximum concurrent number of player sessions that can
be in use.

Min Threads The minimum number of processing threads that are allocated to the
current player session.

Click OK to activate the settings. Click Cancel to exit the Options dialog box.

Telnet Designer Tools
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Chapter3
Using Remote
Procedure Call Mode

The Remote Procedure Call (RPC) mode allows you to generate an RPC containing an
emulation that accesses a discrete piece of information in a legacy mainframe
application.

Using the Telnet Designer, you can run the mainframe application, identify the specific
screens and fields of the particular transaction you want to emulate, and then save it to
an RPC that can be used by the client application at run time. The RPC can be saved as
a stand-alone Java program.

In this chapter:

Remote Procedure Call Mode Overview

Creating a Transaction Module

Remote Procedure Call Mode Overview

The Remote Procedure Call (RPC) mode allows you to generate specialized Java source for the
RPC containing an emulation that accesses a discrete piece of information in a legacy
mainframe application.

At design-time, you use the iWay Emulation Adapter (3270/5250) Telnet Designer to connect
to a mainframe application, then navigate and capture the application transaction you want to
extract. This requires identifying the screens, input fields, and values necessary to access the
information you want, and identifying the fields that you want returned by the transaction to the
client application. You save this information as an RPC program, at which time you have the
option to generate a stand-alone RPC Java program for use on other application servers.

You compile the RPC program to generate an RPC class, which can then be used by the client
application at run time. This RPC class is also referred to as a transaction module because it
holds the information to perform a specific transaction using an application, for example,
retrieving customer account information.
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At run time, your client application sends an XML request document containing the RPC class.
The RPC class works with the iWay Emulation Adapter (3270/5250) to drive the mainframe
application with the required 3270/5250 buffers. In this way, it navigates through the
application to the designated data and returns the requested information in an XML document.
At run time, your client application can:

Send information to a mainframe session. Your client application sends the input
parameter variables required by your mainframe application in an XML request document.

Receive information from a mainframe session. Your client application receives the
designated output data from your mainframe application in an XML response document.

Creating a Transaction Module

A transaction module is the RPC class that defines a single mainframe transaction. The RPC
class is used to run the transaction in a client application. Through the Telnet Designer, you
design the RPC class by designating the mainframe application screens, input parameters, and
target information that make up a transaction.

The process of creating a transaction module consists of:

Accessing the mainframe application in Telnet Designer.

Emulating the transaction. This includes identifying the relevant screens, the fields and
values (Parameters) you must use to move through the application, and the output fields
(Metadata) you want returned to the client application.

Testing the RPC program to verify that you have correctly identified all the necessary
screens and input data to successfully run the RPC, and identified the correct metadata
necessary expected from your application.

Generating the RPC program. You can generate a stand-alone Java program for use in other
application servers.

The following sections describe how to perform these tasks.

Accessing the Mainframe Application

To capture and save an application transaction, you must open the mainframe application
within Telnet Designer. Once connected to the application, you can issue commands and
navigate the application as you normally would and use the emulation tools available in Telnet
Designer to create an RPC program.

Creating a Transaction Module
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Procedure: How to Access a Mainframe Application

To access a mainframe application for an emulation session:

1. Open the Telnet Designer.

The Telnet Designer window opens, as shown in the following image, with the Project tab
active in the left pane.

2. At the bottom of the left pane, click the Sessions tab.

A Sessions folder appears at the top of the left pane.

3. Click Tools from the menu bar and select Emulator.

3. Using Remote Procedure Call Mode
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The following image shows the Sessions folder in the left pane and the Tools drop-down
list.

The Terminal Emulator dialog box opens, as shown in the following image. The Connection
tab, where you provide information about connecting to the mainframe, is active.

4. From the Host drop-down list, select the mainframe you want to emulate.

5. From the Terminal drop-down list, select the terminal type (tn3270 or tn5250) for the
emulation.

Creating a Transaction Module
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6. In the Port field, type the port number to access the host.

7. In the Mode field, click the RPC option button.

8. For more emulation options, click the Advanced tab.

The Advanced tab of the Terminal Emulator opens, as shown in the following image.

Note: The Extended Attributes option is not operational for the RPC mode.

9. Make a selection from the Language drop-down list, shown in the following image. The
Language selection determines the national language character set that will be used in
your emulation session.

10. If you want to use a specific terminal name (LU) or pool name (LU pool) with your
mainframe connection, type this value in the LU Name field.

3. Using Remote Procedure Call Mode
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This option allows the mainframe to dedicate specific connections and privileges to
specific telnet ports.

11. To connect to the mainframe application and start the emulation session, click Run.

A window of the VTAM session opens in the right pane and a folder that represents your
session appears in the left pane. The following image shows an example of the VTAM
window and a session folder named Server(RPC).

Each session folder contains sub-folders that will hold the information related to your
emulation session. The following image shows the left pane of Telnet Designer with the Server
(RPC) session folder and its sub-folders.

Creating a Transaction Module
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The session sub-folders are:

connection. Contains the mainframe application connection information, such as, host, port,
type, and language.

parameters. Contains the input fields and data you designate for the transaction.

metadata. Contains the designated output expected from the transaction.

screens. Contains the information for the designated screens in the transaction.

As you build a transaction session, these subfolders become populated with the transaction
information.

You can now begin your emulation session, and capture the necessary screens and input and
output data, as explained in the following sections.

Capturing a Transaction

To capture an application transaction, navigate through the application and as you proceed:

Identify a screen that is necessary to the transaction. When the adapter executes the
request document at run time, it recognizes these designated screens.

If the screen contains required input fields (Parameters) that require values at run time,
define them to the transaction. The values will be provided in the request document at run
time.

If the screen contains output fields (Metadata) that you want returned at run time in the
response document, define them to the transaction.

Continue to navigate through the application and identify each screen and the input and
output fields that are necessary to the transaction.

Log off the mainframe application and save the emulation session.

The following procedures explain how to perform these tasks.

Note: If you need to include the contents or metadata of a table as input or output in your
transaction, see How to Capture the Contents of a Table on page 44.

Procedure: How to Identify a Screen

To identify a screen to the transaction module:

1. Determine the field(s) on the 3270/5250 screen that uniquely identify it from the other
application screens.

Note: You do not need to identify a blank screen.

3. Using Remote Procedure Call Mode
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If there are several fields, choose one to identify the screen. The following image shows
an example of a field named RUNNING selected in the lower left of the screen.

2. Right-click the identifying field and select Add Screen Identifier.

Creating a Transaction Module
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The Screen Identifier dialog box opens with prompts for identifying the field, as shown in
the following image.

The Screen Name and the Field Number fields are automatically populated based on your
selection.

a. In the Field Text field, type the text that uniquely identifies this screen.

b. Select an option for Match Operation, which is the relationship of the text you typed in
the Field Text field to the complete text of the field in the application. The options are:

Full. The Field Text entry is the complete text of the screen field.

EndsWith. The screen field text ends with the Field Text entry.

StartsWith. The screen field text begins with the Field Text entry.

Contains. The screen field text contains the Field Text entry.

For example, if the field value is OPERATOR INSTRUCTIONS, and you enter OPERATOR
INSTRUCTIONS, the field text you entered is the full text of the field on the screen.
Therefore, select the Full Match Operation option.

Alternatively, if you entered Instructions for that field, select the EndsWith or Contains
Match Operation option.

Note: When a match is made, the adapter proceeds with the keystroke pressed, such
as Enter or a PF key. At run time, the screen is processed accordingly.

3. Click OK.

3. Using Remote Procedure Call Mode

iWay Emulation Adapter (3270/5250) User's Guide  41



You have identified the screen to the transaction module. A folder with the screen name
appears in the left pane, under the screens folder. A folder is created for each screen
identified for the session.

Now you can define the appropriate input and output fields, if any, on that screen.

Procedure: How to Define an Input Field (Parameter)

This procedure uses an example transaction, INQY, and an example input parameter,
NUMBER, to explain how to define input parameters.

Note: It may not be necessary to define parameters on each screen. Define only those input
parameters that are required to navigate the screen, for example userid or password, and is
different for each invocation of the RPC request.

To define screen input parameters:

1. From the desired formatted screen, use the cursor to select a required input field.

For example, to identify the ENTER TRANSACTION field of the IBIVM Operator Instructions
window, enter the INQY transaction.

Creating a Transaction Module
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2. Right-click and select Add Parameter from the drop-down list, as shown in the following
image.

The Add Parameter dialog box opens and prompts you for a parameter name, as shown in
the following image.

3. Type a name that appropriately identifies the input parameter, for example, Account.

4. Click Ok.

5. Repeat these steps for the remaining fields that you want to define as input parameters.

A folder with the parameter name appears in the left pane, under the parameters folder. A
folder is created for each parameter identified for the session

3. Using Remote Procedure Call Mode
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Procedure: How to Define an Output Field (Metadata)

To define the output fields that you want returned by the transaction module as part of the
answer set:

1. From the desired formatted screen, use the cursor to select a desired output field.

2. Right-click and select Add Metadata from the drop-down list

The Add Metadata dialog box opens and prompts you to enter a name, as shown in the
following image.

3. Type a name that appropriately identifies the output metadata.

4. Click OK.

5. Repeat these steps for the remaining fields that you want returned as output.

A folder with the output field name appears in the left pane, under the metadata folder. A
folder is created for each output field identified for the session

Procedure: How to Capture the Contents of a Table

There are times when the mainframe application consists of a screen that displays multiple
rows of data, such as an inquiry or broBSE program. The iWay Emulation Adapter (3270/5250)
allows you to capture the screen once for any number of records that make up that table. For
example, a MENU CICS transaction broBSE function that displays a number of records.

To retrieve all of the records if a table:

1. Click the cursor to the immediate left of the first column of the first record (left corner of
the table) and drag it to the immediate right of the last column of the table.

Creating a Transaction Module
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The Table Metadata window opens, displaying the contents of the table in a row and
column format. An example of this window is shown in the following image.

2. If you want to modify the name of a column, double-click it and make the appropriate
change.

3. Click OK to save the table. The table metadata and output information are automatically
saved.

When you run RPC program, the output of the program will contain a record-like answer set
with all of the information displayed as columns.

Procedure: How to Save the Transaction Session

When you are finished identifying screens, input, and output field, save the transactions
session, as follows:

1. Log off the mainframe application.

Note: The transaction module signs off the application in the same manner.

2. Right-click the server (RPC) icon under the Sessions folder and select Save As from the
drop-down list.

3. Using Remote Procedure Call Mode
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The following image shows the session drop-down list.

The Save As dialog box opens and prompts you to type a name for the save document, as
shown in the following image.

3. Type a name for the session, for example, TelnetHostA.

4. If needed, enter comments in the Remarks field.

5. Click Save.

The requested XML document is saved to

TelnetInstalDir\projects\system\rpcs

Creating a Transaction Module
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where:

TelnetInstalDir

Is the directory into which the emulator product is installed.

system

Is the name of your project. System is the default project name.

The XML request document can be used to generate web services as explained in Creating
XML Schemas and iWay Business Services on page 53.

The new document appears in the left pane under the Sessions folder, as shown in the
following image.

Testing the RPC Program

The RPC application can be tested immediately against the mainframe online application.
Depending on the connection parameters, it can be tested against a prerecorded mainframe
session in which there is no connection to the mainframe.

Testing allows you to verify that you have correctly identified all the required screens and
parameters to run the RPC, and that the desired metadata is returned from your application. If
you are unable to successfully complete the RPC test, review the transaction and confirm that
all the necessary input data is properly assigned, along with the navigation of the transaction
through the various screens.

Procedure: How to Unit Test the RPC

To test an RPC:

1. In the left pane, expand the rpcs node and right-click the RPC you want to test.

Note: Be sure you are working in the desired project.

2. From the drop-down list, select Run.

3. Using Remote Procedure Call Mode
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The following image shows the left pane of Telnet Designer with an example of an RPC
program node and its drop-down list.

The RPC Tool window opens in the right pane, as shown in the following image:

3. Click Parameters to enter the parameter data expected by the RPC application.

Creating a Transaction Module
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The following is an example of the parameters table in which you can enter the test
values.

4. Click Execute. The program runs the CICS MENU transaction to return Account, Address,
and Amount information.

The following image shows an example of test results where the program returns the
information for the record with account number 000022.

The RPC has been tested successfully. You can now generate a Java program from the RPC.

Generating the RPC Program

You can generate an RPC program of your emulation session, a Java program for use as a
standalone Java client, or as a service to be imported into the iWay Emulation Adapter.

3. Using Remote Procedure Call Mode
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Procedure: How to Generate the RPC Program

To generate an RPC program:

1. In the left pane of Telnet Designer, click the Project system tab.

2. Expand the system folder and then, expand the rpcs subfolder.

3. Right-click the RPC design project, for example, MenuInqy, and select Generation.

The following image shows the expanded rpcs subfolder and the drop-down list of the
project.

Creating a Transaction Module
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To generate a Java program that can be included in your client application or run as a
stand-alone component, select Java Class and enter the fully qualified name of the Java
class you want to generate.

The iWay Telnet Designer generates the class under the work subfolder of your current
project.

3. Using Remote Procedure Call Mode
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The iWay Telnet Designer also generates artifacts that can be used to compile and run the
Java program using Apache Ant.

Creating a Transaction Module
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Chapter4 Creating XML Schemas
and iWay Business Services

This section describes how to create XML schemas and iWay Business Services that will
be used to execute the iWay Emulation Adapter (3270/5250).

In this chapter:

Creating an Adapter Transaction

Understanding iWay Business Services

Creating iWay Emulation Adapter (3270/5250) iWay Business Services

Creating an Adapter Transaction

After you have used the iWay Telnet Designer to create a project containing one or more RPCs,
you can import them to the iWay Emulation Adapter in iWay Explorer by specifying the full path
to the root of the project.

Procedure: How to Import a Telnet Project

To import a Telnet project:

1. Open iWay Explorer.

2. Right-click an available configuration to which you want to connect (for example,
SampleConfig) and select Connect from the context menu.
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The following image shows the left pane, where nodes appear for iWay Adapters, iWay
Events, and iWay Business Services (also known as web services).

3. In the left pane, expand the iWay Adapters node and select the Telnet node.

4. Right-click the Telnet adapter node and select Add Target.

Creating an Adapter Transaction
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The Add Target dialog box opens.

5. In the Name field, type a descriptive name for the target, for example, TelnetTarget.

6. In the Description field, type a brief description of the connection (optional).

7. From the Type drop-down list, select Telnet Project.

8. Click OK.

The Telnet Project dialog box opens, as shown in the following image.

9. Specify the full path to the Telnet project in the Project Folder field.

10. Click OK.

The new target, for example, TelnetTarget, appears in the left pane beneath the Telnet
node.

11. Right-click the target, for example, TelnetTarget, and select Connect.

4. Creating XML Schemas and iWay Business Services

iWay Emulation Adapter (3270/5250) User's Guide  55



In the left pane, the TelnetTarget node changes to reflect that a connection was made.

Selecting a service node will provide the details of the RPC connection and the associated
XML request and response schemas for the service in the right pane of iWay Explorer.
Right-clicking on a service node will allow you to test execute the service and to edit the
connection details and default parameter values for the service. If you have edited the
service and want to restore the original values from the imported project, a Restore
Settings option is available.

Understanding iWay Business Services

iWay Explorer provides web developers with a simple, consistent mechanism for extending the
capabilities of the iWay Emulation Adapter (3270/5250). The iWay Business Services Provider
(iBSP) exposes functionality as iWay Business Services (also known as web services). It serves
as a gateway to heterogeneous back-end applications and databases.

A web service is a self-contained, modularized function that you can publish and access across
a network using open standards. It is the implementation of an interface by a component and
is an executable entity. For the caller or sender, a web service can be considered a black box
that may require input and that delivers a result. Web services integrate within an enterprise
as well as across enterprises on any communication technology stack, whether asynchronous
or synchronous, in any format.

Creating iWay Emulation Adapter (3270/5250) iWay Business Services

When using iWay Telnet Designer in RPC mode, iWay Telnet Designer automatically creates an
XML document for the RPC session that is saved. This XML document is a script that is based
on the saved session. You can create an iWay Business Service (web service) for the iWay
Emulation Adapter (3270/5250) using this generated XML document.

Procedure: How to Create an iWay Business Service

To create an iWay Business Service using an XML document generated by iWay Telnet
Designer:

1. Follow the instructions in Using Remote Procedure Call Mode on page 33, to generate an
RPC session. An XML document of this session is automatically generated.

Understanding iWay Business Services
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2. Open iWay Explorer, create, and then connect to an emulation adapter (Telnet) target
node.

For more information, follow the steps in How to Import a Telnet Project on page 53.

3. In the left pane, expand the target node, followed by the Generated Scripts node.

4. To generate the request and response schema, select the XML document that
corresponds to your RPC session.

The Request Schema and Response Schema tabs appear in the right pane. To view the
XML for each schema type, click the appropriate tab.

5. Right-click the XML document from which you want to create a business service and select
Create Web Service.

The Create Web Service dialog is displayed.

6. Perform the following steps:

a. From the Existing Service Names drop-down list, select either <new service> or an
existing service.

b. If you are creating a new service, specify a service name. This name identifies the
web service in the list of services under the Business Services node.

c. Enter a brief description for the service (optional).

7. Click Next.

The License and Method dialog is displayed.

8. Perform the following steps:

a. In the License Name field, select one or more license codes to assign to the web
service. To make multiple selections, press the Ctrl key and click the licenses.

b. In the Method Name field, enter a descriptive name for the method.

c. In the Method Description field, enter a brief description of the method.

9. Click OK.

iWay Explorer switches the view to the Business Services node, and the new iWay
Business Service (web service) appears in the left pane.

4. Creating XML Schemas and iWay Business Services
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Chapter5
Using Emulation and
Recorder Modes

The iWay Emulation Adapter (3270/5250) provides an Emulation mode in which you can
access a mainframe session directly from your workstation using Telnet Designer. Telnet
Designer displays standard 3270/5250 screens.

The adapter also offers a Recorder mode in which you can record an emulation session
for use at a later time, for example, to simulate a connection to the mainframe for
debugging purposes.

This section explains how to use the iWay Emulation Adapter (3270/5250) in Emulation
Mode and Recorder Mode.

In this chapter:

Using Emulation Mode

About Recorder Mode

Creating a Prerecorded File

Developing Against a Prerecorded File

Using Emulation Mode

The adapter Emulation mode enables you to access a mainframe session directly from the
iWay Emulation Adapter (3270/5250) Telnet Designer. This is a simple emulation that displays
standard 3270/5250 screens and does not create any work files on your system.

Emulation mode enables you to access the mainframe as you develop Telnet applications.

Procedure: How to Run Emulation Mode

To run the adapter in Emulation mode:

1. From the Telnet Designer main menu, select Tools and then Emulator. You can also click
the Emulator Tool icon.
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The Terminal Emulator opens in the right pane with the Connection tab active, as shown in
the following image.

2. On the Connection tab:

a. From the Host drop-down list, select the system host you want to emulate.

b. From the Terminal drop-down list, select either tn3270 or tn5250 as the terminal type
used in the emulation.

c. In the Port field, type the port number through which you will connect to the system
terminal.

d. Select Emulation as the Mode option.

3. For more emulation options, click the Advanced tab.

The Advanced tab of the Terminal Emulator opens. Make a selection from the Language
drop-down list. The Language selection determines the national language character set
that will be used in your emulation session.

If you want to use a specific terminal name (LU) or pool name (LU pool) with your
mainframe connection, type this value in the LU Name field. This option allows the
mainframe to dedicate specific connections and privileges to specific telnet ports.

Using Emulation Mode
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4. Click Run.

A connection is made to the mainframe online system and the initial mainframe screen
opens. The following image is an example of a mainframe screen in Telnet Designer.

5. Enter the appropriate information to navigate through the mainframe online system of your
site.

Terminate the emulation session at any time by clicking the X in the upper right corner of the
mainframe window.

About Recorder Mode

iWay Emulation Adapter (3270/5250) Recorder mode enables you to capture your mainframe
application screens and end user keystrokes using Telnet Designer in terminal mode and then
stores these screens and keystrokes in a binary file.

This file can then be used by Player Server to simulate a connection to the mainframe, allowing
you to continue your development without a live connection. Capturing a session in Recorder
mode is useful for offline development, testing, benchmarking, prototyping, debugging, and
demonstration purposes.

5. Using Emulation and Recorder Modes
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Creating a Prerecorded File

Use the Recorder mode to create a file that can be used with Player Server to simulate a live
connection to the mainframe. Each screen, keystroke, and text entry that you enter is recorded
into a dump file. When you play it back with the Player Server, this recorded session is played
back exactly as you navigated through your screens. This allows you to design RPC mode
sessions against these screens or use the session for offline testing or debugging.

Procedure: How to Record an Emulation Session

To use Telnet Designer in Recorder (REC) mode:

1. From the Telnet Designer main menu, select Tools and then Emulator. You can also click
the Emulator Tool icon.

The Terminal Emulator window opens with the Connection tab active, as shown in the
following image.

2. On the Connection tab:

a. From the Host drop-down list, select the system host from which you want to record.

b. From the Terminal drop-down list, select either tn3270 or tn3250 as the terminal type
used in the session.

c. In the Port field, type the port number through which you will connect to the system.

Creating a Prerecorded File
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d. Select Rec as the Mode option.

3. For more emulation options, click the Advanced tab.

The Advanced tab of the Terminal Emulator opens. Make a selection from the Language
drop-down list. The Language selection determines the national language character set
that will be used in your emulation session.

If you want to use a specific terminal name (LU) or pool name (LU pool) with your
mainframe connection, type this value in the LU Name field. This option allows the
mainframe to dedicate specific connections and privileges to specific telnet ports.

4. Click Run.

A connection is made to the mainframe online system.

The mainframe session window opens in the right pane of Telnet Designer. The following
image shows an example of a mainframe window in Telnet Designer.

5. Enter the appropriate information to navigate through the mainframe online system, as
needed.

As you move through each screen of the mainframe, session information is written to a
file.

5. Using Emulation and Recorder Modes
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6. When you are finished with the mainframe session, log off of the mainframe. For example,
for CICS, issue the CESF LOGOFF command.

7. Close the mainframe session window by clicking the X in the upper right of the mainframe
window.

8. To save the prerecorded file, right-click the Server (RECORDER) node in the left pane and
select Save As, as shown in the following image.

Creating a Prerecorded File
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The Save As dialog box opens, as shown in the following image.

9. In the Name field, type a name for the recorded session file, for example, REC1.

Note: Entering information in the Remarks field is optional.

10. Click Save.

11. In the left pane of Telnet Designer, click the Project tab and expand the dumps folder.
When the recorded session is saved, it appears under the dumps folder.

5. Using Emulation and Recorder Modes
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The following image shows an example prerecorded file, REC1, under the dumps folder.

You are ready to develop against the prerecorded file.

Developing Against a Prerecorded File

The Player Server executes against a prerecorded file containing your recorded session activity.
You can create several files where each one can simulate a specific online application, such
as a browse transaction or an update transaction. You can also create one large file that
encompasses many mainframe transactions, enabling, for example, two or more developers to
work on separate transactions on a laptop that is disconnected from the actual mainframe.

You have all options available to create an iWay Emulation Adapter (3270/5250) application
against a prerecorded file. As explained previously, you can run the Telnet Designer to create
an RPC solution. The difference when running against a prerecorded file, is that development
is not running against the mainframe. There is no mainframe connection.

This section provides procedures that describe how to:

Start a player session against a prerecorded file.

Developing Against a Prerecorded File
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View or change the Player Server connection information.

Telnet Designer enables you to control the port on which the Player Server is running. The
default port is 1010. You can change the port number to any desired number. The port
number is used to connect to the Telnet session to create an adapter application.

Run Telnet Designer against a prerecorded file.

While the Player session is running, you can run Telnet Designer against it to create an RPC
application. You can use Telnet Designer as if you were connected to the mainframe.

Procedure: How to Start a Player Session Against a Prerecorded File

To start a player session against a prerecorded file:

1. In the left pane of Telnet Designer, expand the dumps node under your project to view all
the prerecorded files.

2. Right-click the prerecorded file of interest and select Start.

The Player tab becomes available in the lower right pane. The following image shows this
tab with the example prerecorded file, REC1.

5. Using Emulation and Recorder Modes
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3. Click the Player tab.

The Console Window displays the port number on which the player is running.

Note: Port 1010 is the default port.

Procedure: How to View or Change the Player Server Connection Information

To view or change the Player Server connection information:

1. In Telnet Designer, click Tools and select Options.

The Options dialog box opens.

2. Click the Player Server tab.

The following image shows the Options dialog box open with the Player Server tab
selected.

3. In the Initial Port field, type the port number your Telnet Designer tool will use to connect
to the iWay Emulation Adapter (3270/5250).

4. In the Max session field, type a value to indicate the span of port numbers that may be
used. For each new Player Server session that is opened against Telnet Designer, the
Initial Port number is incremented by 1. As each new session is opened, a new port
number is assigned.

5. In the Min Threads field, type the minimum number of processing threads that are
allocated to the current player session.

6. Click OK.

Developing Against a Prerecorded File
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AppendixA
Emulator Keyboard
Mapping

This section describes how your keyboard maps to 3270/5250 keys when you are using
the iWay Emulation Adapter (3270/5250).

In this appendix:

Emulator Keyboard Mapping

Emulator Keyboard Mapping

The following table lists 3270/5250 keys in the left column and corresponding keyboard
equivalents in the right column.

3270/5250 Key Keyboard

PF1 - PF12 F1 - F12

PF13 - PF24 Shift + F1 - Shift + F12

Clear Ctrl + C

PA0 Alt + F1

PA1 Alt + F2

PA3 Alt + F3

Page Up Page Up

Page Down Page Down

Forward Tab Tab or Ctrl + F

Backward Tab Shift Tab or Ctrl + B

Rubout Backspace

Delete Delete or Ctrl + E
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3270/5250 Key Keyboard

Home Home

New Line Ctrl + N

Emulator Keyboard Mapping
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Feedback
Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented
individuals who work together to design and deliver quality technical documentation products.
Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and
services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor,
Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino,
Vice President, Technical Content Management at Frances_Gambino@ibi.com.
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